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Comparison
How does BackBit line up to other storage solutions for your vintage hardware? Let’s find out!
1541

BackBit

SD2IEC

EasyFlash3

Pi1541

Ultimate-II+

Powered by Machine

N

Y

Y

Y

N

Y

C128 Compatibility

Y

Y

Y

N

Y

Y

VIC 20 Compatibility

Y

Y

Y

N

Y

N

Boot directly to menu

N

Y

N

Y

N

Y

# of Cables Required

2

0

Up to 2*

0

2

1

8MB

No Limit

No Limit

Maximum Capacity

170KB

32GB

32GB

(per disk)

(per card)

(per card)

4GB

16MB

1MB

800KB

1MB

(BBT)

(DNP)

(CRT)

(D81)

(CRT)

n/a

$99

$60

$65

$70

$150

Y

N

Y

N

Y

Varies***

D64 Compatibility

n/a

Partial#

Partial#

Minimal****

Full

Full

Transfer Mechanism

n/a

SD

SD

USB

SD/USB

USB/RJ45

Max. Capacity/File

n/a

Typical Price
Fastloader Req’d for
Maximum Speed

* SD2IEC variations exist: (1) no cables plugging directly into IEC & cassette port on C64 (incompatible w/ C128 and SX-64);
(2) no cables internally mounted (assembly required); (3) single cable plugging directly into tape port (incompatible w/ SX-64).
** Speeds can be improved by using software fastloaders, KERNAL replacements (assembly required), and CRT format files.
*** Ultimate-II+ requires a fastloader for multi-file disk images; for onefile programs and cartridges it does not.
**** Using Disk2EasyFlash, it is possible to make conversions, but they are read-only and do not support SEQ/REL files.
# Compatibility is close to 100% with programs that use only standard KERNAL routines.
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Philosophy
When I had access to some Commodore 64s back in 2018, I was searching for the ideal
solution to make it easy to load programs. The 1541 disk drive proved to be way too tedious,
unreliable, and painfully slow.
I spent some time researching more modern media solutions for the Commodore 64, like the
ones listed in the table above. While these solutions did provide some convenience as
compared to a 1541 disk drive, they did not perform to my expectations. Individually all of these
devices have some impressive features, but they all require a steep learning curve. I wanted
something that was more of an effortless all-in-one solution.
My initial vision was to have something like popping a cartridge into the C64GS (Commodore 64
Games System). That was the final revision of the C64, produced in 1990 at a time when Sega
& Nintendo had already taken over much of the gaming market (making it a flop). But what if
something like the C64GS came out earlier? What if there was a device to turn any Commodore
64 into a C64GS? Well, that vision became BackBit.
My original sketch showed a device that essentially combined the best bits of the SD2IEC and
the EasyFlash:
●
●
●
●

Like the EasyFlash, it would plug into the cartridge port, allowing autostart;
Like the SD2IEC, it would take an SD card so as to allow instant access to an effectively
unlimited amount of storage (with no EEPROM flashing required);
Like the EasyFlash, starting a game would be instant;
It would have access to a large library of downloadable software.

I originally envisioned a device like a 3-legged octopus that would at the same time plug into the
cartridge port (for autostart), tape port (for power), and IEC port (for data access). But I soon
realized that I could make it simpler. The cartridge port provides power, making the tape port
unnecessary. Furthermore, I discovered that I could override a part of the C64’s built-in
operating system, the KERNAL, to facilitate the loading of unmodified disk images without being
physically plugged into the disk drive port (copy-protected images excluded).
While initially I saw the lack of full 1541 emulation as a limitation, I soon realized that it was a
feature. With BackBit, you never have to wait for loading, and never have to swap a disk, EVER.
To extend compatibility beyond single-disk non-copy-protected titles, I created the open source
BBT file format, described later in this document under the section BackBit Tool, which offers a
near unlimited-capacity one-file solution for developers and hobbyists alike.
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How It Works
Many storage solutions emulate the original 1541 disk drive, inheriting challenges such as:
●
●
●

The need for fastloaders to provide reasonable loading speeds;
The need for disk swapping to exceed 170K of program data and content;
Typing convoluted commands to browse and load programs.

Other solutions allow for easy access to programs, but are often limited:
●
●
●

They require intricate tools to set up;
You have to choose between a limited number of titles;
They don’t support common file formats.

BackBit incorporates the best of both worlds, completely eliminating the need for fastloaders,
disk swapping, and the typing of convoluted commands, while offering a nearly unlimited
capacity of common file formats, accessible on any microSD card.

BackBit Levels
To make it easy to understand the operation of BackBit, you can break it down into 3 levels:
LEVEL I: Loads single-file programs, including programs up to 62KB in size and generic 16KB
cartridges. Many devices can do this already, so this is just the basic functionality you would
expect from a storage device.
LEVEL II: Emulates up to 8 disk images at the same time, spanning from device 8 to 15.
Rather than relying on the IEC port, this emulation happens through KERNAL vectors. If a
program does not implement copy protection, chances are it will work perfectly from the original
disk image. Games that are a great example of this include Lode Runner, Ultimate Wizard,
Jumpman and many games designed to work with IDE64. While only a single 1541/71/81 disk
image can be used by default, you can create a BBT file with the BackBit Tool to use all 8 slots.
LEVEL III: Accesses up to 4GB of extended data. Is this really a limit? Not really, since it
would take the C64 about a day just to process that much information. To access extended
data, you must use the BackBit Tool to package a BBT file and then use the BackBit API to
access the data. More details are explained later in this document.
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Anatomy

The Menu Button up top allows you to return to the menu once a program is running.
The Indicator Light lets you know when requests are being made to the cartridge.
The SD Card slot accepts any microSD card formatted to FAT32 or FAT16. The slot is designed
so that cards will not “fall in” to the cartridge and will be easy to remove.
Connect a Micro USB cable to upgrade firmware. Once software is set up correctly, press the
Update button to perform the update. It is not possible to “BRICK” the cartridge. In case of a
failed update, you can easily restart the upgrade process.
The wired remote allows you to connect a BackBit Button (available for purchase separately),
which simply breaks out the indicator light and menu button, so you don’t have to reach behind
the computer, which can sometimes cause unacceptable static electricity interference.

Summary of Features
●
●
●
●
●
●
●
●
●
●
●

Load programs from microSD card formatted with FAT16/32 (32GB limit);
Firmware is upgradeable via USB cable;
“Rip & Burn” – built-in disk copier to facilitate archiving/reproducing real disks;
Built-in SID player and Koala viewer
Real time clock to facilitate accurate versioning of files (w/ replaceable CR2032 battery);
Innovative BBT file format to assemble and run multi-disk programs w/o disk swapping;
Extended data access provides up to 4GB of data per program;
Physical button to return to menu from active program;
Auto-Start mode: Automatically start a specific program w/o user interaction;
Presentation mode for exhibiting programs non-destructively;
Optional wired remote control (available for purchase separately).
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Firmware Upgrade
It is possible to upgrade the firmware via a USB cable. You will need a Micro USB cable and a
paperclip to complete this process. Make sure the cable is a data cable, not merely a charging
cable.
The latest firmware can be downloaded at http://backbit.io/downloads/Firmware.
The first time you upgrade, you will have to download some software:
https://www.pjrc.com/teensy/loader.html
Instal the Teensy software as instructed for your operating system. Just download the program,
you don’t need the LED Blink example program. Once it is downloaded, you may want to copy it
to a more accessible place (Applications for OSX or start menu for Windows).
Plug in the USB cable—one end to your computer and the other end to the USB port on the
BackBit cartridge. It doesn’t matter if the cartridge is plugged into the Commodore 64 or not, or
whether or not the Commodore 64 is turned on.
Go to the File menu and click Open HEX File. Select the .HEX firmware file you downloaded (it
will need to be extracted from the .ZIP container). Now use the paperclip and gently press the
program button on the BackBit cartridge (in between the “B” and “a” letters in “Back”, or if you
have a bare cartridge it’s the beige button next to the right of the SD slot.) You should see a
progress bar indicating the firmware is transferring to the cartridge.
Once this process is complete, unplug the USB cable and reboot your Commodore 64. To verify
the firmware version on the cartridge hold shift or activate shift-lock while the computer is
booting up. The version is in the top-right corner.
Troubleshooting: If the Teensy application does not recognize the device, you may have to try
rebooting your computer or using another cable.
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File Browser
The BackBit file browser allows you to navigate the entire contents of your SD card. There are a
few restrictions in how your card must be arranged:
● Must be formatted in FAT32 (or FAT16);
● Must have a folder entitled BACKBIT (case-insensitive) in the root folder of your card;
● Folders over 1,000 files will show “<MORE>” at the end of the listing to browse additional
files (due to memory restrictions of the device).
Key Conventions:
↑ Key functions the same as SHIFT + ⇑CRSR⇓.
← Key functions the same as SHIFT + ⇐CRSR⇒.
In many cases either Joystick #1 or Joystick #2 can be used instead of cursor keys.
Press any function key to see a reference of function commands on the status bar.

🕹
🕹
🕹
🕹
🕹
🕹

Browser Commands:
Up / ↑ / SHIFT + ⇑CRSR⇓- Navigate to last files or item
Down / ⇑CRSR⇓ - Navigate to next file or item
Left / ← / SHIFT + ⇐CRSR⇒ - Navigate to last page
Right / ⇐CRSR⇒ - Navigate to next page
Fire / RETURN - Choose selected item
+ RETURN / CTRL + RETURN - Open selected disk without automatically starting
A - Z / 0 - 9 / Space Bar - Search for title beginning with selected characters
CLR HOME - Reset search / Go to top of listing
INST DEL - Remove last search character / Close popup / Navigate to parent directory
RUN STOP - Open BASIC session
RESTORE - Refresh directory (useful after swapping SD Card or encountering error)
F1 / ESC - Show UTILS menu (not specific to any item), or hide if already visible.
F3 - Show PROPS for current item, or hide if already visible.
F5 - Show SAVES for current item, or hide if already visible.
F7 - Show TOOLS for current item, or hide if already visible.
SHIFT LOCK - Select on bootup to show technical information

Clock
BackBit comes with a Real Time Clock. This means that even when the power is shut off, your
cartridge will remember the time of day. To set the clock for the first time, choose Set Clock from
the UTILS menu. Use the cursor keys to navigate the fields and modify values. Be sure to set
your time zone, indicated as an offset from UTC. Press return to save changes or menu button
to abort.
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Loading Programs
These file formats are supported:
● PRG/P00 (single program up to 62KB);
● T64 (only supports loading first program from tape image);
● BIN (generic 8K/16K/32K* cartridges);
● CRT (incl. generic 8K/16K/32K*/Ultimax, C64GS/System3, Dinamic, Funplay/Powerplay,
Magic Desk, Ocean, Prophet 64, Simons Basic, Super Games, Zaxxon);
● VIC 20/VC20 cartridges: 20/40/60/70/A0/B0 (see more details in VIC 20/VC20 section
below).
● D64/D71/D81 (1541/71/81 disk; emulated using KERNAL vectors);
● BBT (BackBit format; see BackBit Tool section).
(*32K cartridges only work on C128)

The file formats are unsupported at this time, but support may be added for them in the future:
●
●
●
●

●

G64/NIB files: BackBit does not physically connect to a disk drive, so it cannot generate
these advanced formats. Use NIBTools to convert these files to D64;
TAP files: BackBit does not emulate tape loading. Convert these to a format BackBit can
recognize, like PRG or D64;
T64 files with more than 1 program: Try converting these to individual PRG/D64 files;
Disk-based programs that access the serial port directly at $DDXX or through KERNAL
serial device routines, incl. fastloaders: Since BackBit does not physically connect to the
C64’s serial port, it cannot handle these requests. Fortunately, there is a patching
system being built into BackBit to make it possible to run a growing library of programs;
Certain EasyFlash CRT files: These cartridges push the instant-access capacity of
BackBit, however there is growing support to make the entire EasyFlash library work.

Presentation Mode
Accessible via the UTILS menu (F1), this puts the cartridge in Presentation Mode, identifiable
with a blue border. This allows the cartridge to be used in an exhibit or party environment.
Presentation Mode operates similarly to the File Browser with these exceptions:
● Function Key menus and directory refresh are unavailable;
● The last directory navigated in the File Browser is the only one accessible;
● All contents of the current directory are recursively combined into one list;
● Hold menu button while physically resetting computer to disable Presentation Mode.
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Autostart Mode
Accessible via the Tools menu (F7), this puts the cartridge in Autostart Mode. In this mode, the
selected program is started automatically upon bootup. Aside from aesthetics, this mode can be
helpful for some cartridges that work better on a clean boot.
While in Autostart Mode, the following restrictions apply:
●
●
●

The File Browser is inaccessible;
The menu button resets the program;
Hold menu button while physically resetting computer to disable Autostart Mode.

Rip/Burn
With BackBit, it is possible to read and write disks with a real 1541 disk drive, simply by plugging
the drive into your C64 at the same time the Cartridge is present.
To “Rip” a disk, select this option from the UTILS menu (F1). Then choose a device to read and
press return. The disk will be saved as “New Disk” (or as a version inside that disk if one is
already present).
To “Burn” a disk, select this option from the tools menu (F7). Only D64 images can be written to
a 1541 drive. Then choose a device to write to and press return.

CRT Support
By default, BackBit natively supports cartridges up to 128KB, and uses a patching system to
support cartridges up to 1MB in size. Some C64 revisions, such as the NTSC C64C have a
smaller window in which they require data to be sent from the cartridge. Because of this, there
can be some flaky behavior with certain cartridges. To remedy this problem, you can enable
CRT Support: Compatibility Mode through the UTILS menu (F1) to always use the patching
system, regardless of cartridge size.
This mode usually improves compatibility, but there are a few titles (often PAL only) which will
not work properly this way, which is why it is turned off by default. If you have any problems
getting a particular CRT working on your system, please ask for help with your specific issue at
http://forum.backbit.io.
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Ultimax Support
By default, BackBit emulates Ultimax cartridges as though they were normal programs. This is
to improve compatibility. It is also possible to enable Native support through the UTILS menu
(F1) which should work in most cases, but may create visual artifacts. Particularly useful here is
the ability to autostart advanced cartridges such as Dead Test or KERNAL replacements.

VIC 20/VC20 Adapter
There is an optional adapter to plug in the BackBit cartridge into your VIC 20/VC20 computer.
The BackBit cartridge will detect which system it is being plugged into automatically. Although
Commodore 64/128 cartridges are completely different than VIC 20/VC 20 cartridges, the
adapter compensates for this difference, and BackBit has a completely different way of talking
to the VIC 20/VC20.
Once this adapter is installed, you will be able to boot into BackBit from your VIC/VC computer
with a limited 22-column screen. From the F1 menu, you can then select RAM Expansion, from
0K to 35K. Up to 24K will show up instantly in BASIC, and the rest will be accessible from
machine code. Based on the amount selected, your program and screen location will change:
Expansion

Program start

Screen start

Color start

0K

$1000

$1E00

$9600

3K

$0400

$1E00

$9600

8K+

$1200

$1000

$9400

In the F1 menu, C64-specific options like CRT and Ultimax support will be hidden.
About VIC 20/VC20 cartridges: These are raw binaries with no header. The extension must
match the first 2 hex characters of the loading address, i.e. a $A000-loading cartridge will be
.a0. If you have a 2-part cartridge, i.e. some memory at $2000 and some at $A000, the autostart
portion at $A000 can simply be binary-appended to the first part, as BackBit will detect the
autostart code, i.e. cat cart.20 cart.a0 > combined.20 on a unix-compatible command-line or
copy /b cart.20 + cart.a0 combined.20 on Windows.
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C128 Mode
BackBit supports loading during “SLOW” mode, the default operating mode of the C128.
Note that if you lock the C128 in C64 mode by modifying the reset vector at $FFF8, it will not be
able to start another C128 program without physically resetting the machine.

Properties
Access properties by pressing F3. This will give you detailed information about a file and allow
you to rename it by pressing enter on the name. More options will be provided in future updates,
as specifications are ironed out (such as the ability to configure menu-based access to
documentation, graphics, title images and music).

Saves
Access saves by pressing F5. Then choose an item with RETURN and it will show a popup
menu with actions. Normally when you open a disk image, it loads the most recent modifications
that have been made, such as high scores, user progress or levels. By selecting the original
version here, you can load the original unmodified version of the program. You can also do
many things with modified versions of the program:
●
●
●
●
●

Open a specific version, i.e. an adventure game with your user’s progress;
Rename the version;
Duplicate, i.e. fork the version;
Erase the version;
Export to a regular disk image, so that the version doesn’t have to be associated with the
original disk anymore.

© 2019 BackBit

10

Destructive Operations
Preservation is a key goal in the BackBit user experience. By default, no original disk image will
be modified. It’s as though every disk in BackBit has a backup of the original stashed away.
However, there are a few ways you can potentially destroy content, and they should be used
with caution:
●
●
●

Using the Erase option from the Tools menu (F7). There will be a popup that asks you if
you are sure;
In the Saves menu (F5), you can erase a specific version;
Write errors may occur depending on the quality of the SD card you use, static
electricity, or poor connections—so it is recommended that you periodically backup your
data to another medium.

BackBit Tool
The BackBit Tool is an open source cross-platform application available for Linux (32-bit and
64-bit), Mac (64-bit) and Windows (32-bit and 64-bit). Using the tool, you can assemble BBT
files which are composed of 3 parts:
1. An auto-start program, i.e. PRG file that will be executed on startup (this is optional, and
if not present, a disk image must be present).
2. Up to 8 disk images (D64/D71/D81), assigned automatically to devices 8 through 15. If
there is no auto-start program specified, the application will start with LOAD”*”,8,1
3. A single binary file, no larger than 4GB that will be available through the API for
extended data access.
The source code is available at https://github.com/evietron/BackBit-Tool.
The compiled application is free to download and available at http://backbit.io/downloads.

BackBit API
The API is made of up “peeks” and “pokes” to the I/O area in memory related to the expansion
port, i.e. memory locations $DE00-$DFFF in hex. You must have a knowledge of machine
language programming to effectively implement features of this API, although it is also possible
to use the BASIC programming language to work with most of these features. In that case, you
will have to convert these hex numbers to decimal.
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Peek Commands
This section describes what is obtained when peeking bytes from the I/O area at $DE00-$DFFF.
Peek Commands: CODE
$DE00 $DE02

Identifier. These bytes always return the sequence $BA $CB $17 while the
cartridge is active.

$DEFF

Device Number Filter. This is the maximum device # that the KERNAL emulation
will bypass, so it will typically be one less than the first device # emulated, i.e. $07
if you are using device 8. If KERNAL emulation is not active, this will be $FF.
Peek Commands: DATA

$DF00 $DFFF

Requested data. Data appears here in 256-byte blocks when requested from
Extended Data or Real Time Clock. Poke to $DF## to configure which 256-byte
block out of up to 64K can be accessible here, i.e. $DF00 to get the first block and
$DFFF to get the last.

Poke Commands
The cartridge interprets poke commands based on the address written to, WHILE IGNORING
WHAT DATA IS WRITTEN. This means that you can interchangeably use STA, STX, or STY
instructions when writing to the cartridge at $DE00-DFFF, and can safely ignore the contents of
the A/X/Y registers while doing so. The lower 8-bits of the address are interpreted as a
command on the I/O1 channel ($DE##) and as data on the I/O2 channel ($DF##). For
commands that require parameters, poke each parameter byte to $DF##, then execute the
command at $DE##.
To prevent conflicts with programs that send non-BackBit requests to the $DE## memory area,
all commands, with the exception of disabling the cartridge memory, have a suffix of $BB.
When a command is executed, the cartridge will temporarily become unavailable while it is
performing the command. This does not interrupt the Commodore’s CPU at all, but it makes any
cartridge memory, requests & KERNAL usage inaccessible until the command completes. To
determine if the operation has completed, check for the 3-byte identifier (BA CB 17) at $DE00.
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Poke Commands: PARAMETERS
$DF00 - $DFFF Send parameter data. This will add the low byte of this address to the
parameter buffer, i.e. $DF00 will send $00 and $DF34 will send $34. The
parameter buffer is limited to 256 bytes, after which it resets and wraps
around. In loader or extended data mode, the most recent parameter byte
written is used to specify the high address byte.

Poke Commands: CONTROL
These requests control basic interaction with the cartridge.
$DE00

Disable cartridge memory. Disables access to cartridge memory at
$8000-$AFFF. Facilitates hiding the cartridge from a loaded program.
Does not affect the I/O area at $DE00-$DFFF.

$DE01 [BB]

Enable cartridge memory. Re-enables access to cartridge memory.

$DE02 [BB]

Return to browser. Informs the cartridge that the program is done and
should go back to the browser.

$DE03 [BB]

Turn on LED until next request. LED remains on until next request.

$DE04 [Y# M# D#
H# M# S# Z# BB]

Adjust real time clock. Modifies the time to Y
 ear (+2K) /
Month (1-12) / Da
 y (1-31) Hour:Min:Se
 cond in Zone (signed, +/- UTC).
Time is retained by the cartridge even after powering off the machine.

$DE05 [BB]

Request real time clock. After calling, access the values here:
$DF00 - $DF03: Year in ASCII
$DF04 - $DF05: Month in ASCII
$DF06 - $DF07: Day in ASCII
$DF08 - $DF0B: Matches values you’d expect in $DC08 - $DC0B.
$DF0C: Time zone (signed byte, +/- UTC).
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Poke Commands: EXTENDED DATA
This feature allows BackBit to access up to 4GB of data from a single program. While this
command can take a fraction of a second to run, it sets up a full 64K of data for instant
access, 256 bytes at a time. Requested data will be available at $DFXX with bank switching
triggered by writes to the same area. A single poke to $DFXX switches between 256 byte
blocks instantly. Use the BackBit Tool to attach data to a BBT file which uses this feature.
$DED0 [A# BB]

Access data. Specify 8-bit 64K bank, i.e. $00A#0000

$DED1 [A# B# BB]

Access data. Specify 16-bit 64K bank, i.e. $B#A#0000

$DED2 [A# B# C# BB]

Access data. Specify 24-bit offset, i.e. $00C#
 B#A#

$DED3 [A# B# C# D# BB]

Access data. Specify 32-bit offset, i.e. $D#C#B#A#

Coding Examples
Example BASIC program to turn on cartridge LED:
10 POKE 57275,0 This accesses location $DFBB, sending the $BB parameter
20 POKE 56835,0 This accesses location $DE03, sending the LED command
Example machine language program to access extended data at address $HHMMLL:
STA $DFHH ; access specified 64K data bank
STA $DFBB ; send BB command suffix
STA $DED0 ; extended data access command
JSR WaitForAlive ; make sure memory at $DE00...$DE02 returns $BA,$CB,$17
; note that while waiting for process to complete, KERNAL methods are inaccessible
STA $DFMM ; access 256-byte block of requested data bank
LDA $DFLL ; access single byte of specified 256-byte block
Note that you can make unlimited requests to data inside a 64K bank once the bank is
requested, and you can make unlimited requests for a byte within a 256-byte block once it is
requested. So in summary, these are the access times for any given data:
● 4-6 CPU cycles for the LDA/X/Y to access single byte (w/ optional increment and offset);
● 4-7 cycles for STA/X/Y (w/ optional increment/offset) to get next 256-byte block;
● Fraction of a second to queue up another 64K of data using command request and
polling to determine when cartridge comes back online. During this time the C64 can
perform other processing.
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Optional Accessories
There are many fun and useful accessories to go along with your BackBit cartridge!
●

Case: The case is 3D printed with ABS, making it sturdy and protective of static
discharge.

●

BackButton™ Wired Remote: Allows you to reset your BackBit back to the menu without
having to reach to the back of the cartridge (particularly convenient for models such as
the C128D and SX-64).

●

TwoBit™ Joystick Doubler: Lets one joystick control both ports.

●

VIC 20 Adapter (Pre-Order): Lets you use your BackBit cartridge with the VIC 20!

●

Gen-Assister (Pre-Order): Lets you plug a Sega Genesis/MegaDrive joystick safely into
your Commodore 64, and supports dual fire buttons.

●

All accessories are available for purchase at http://store.backbit.io.

The BackBit Forum™
This cartridge is being actively supported, so if you have any trouble whatsoever, please join the
public forum at http://forum.backbit.io.
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